
Lighting Control System
for Mac OS X and PC Windows

Reference Manual – 1.8

Copyright © 2011-2018 DB AUDIOWARE LTD

Page 1



CONTENTS

Contents.......................................................................................................................... 2

D-Pro Software License Agreement................................................................................ 7

Acknowledgements..................................................................................................... 8

Welcome!......................................................................................................................... 9

D-Pro Licensing Scheme – 8 Universe License.......................................................... 9

D-Pro Licensing Scheme – 2 Universe License.......................................................... 9

Installing D-Pro (8 Universe Unikey dongle)................................................................. 10

Installing D-Pro 2U (License number)............................................................................11

Selecting a language..................................................................................................... 12

Quick Workflow Overview..............................................................................................13

Creating a new show................................................................................................. 13

Patching your lighting fixtures....................................................................................14

Define the dmx hardware.......................................................................................... 15

The device browser and library windows...................................................................16

creating groups.......................................................................................................... 17

Creating cues and palettes........................................................................................ 18

Cuelists...................................................................................................................... 19

Audio Events.......................................................................................................................... 19

DMX output window...................................................................................................20

Show Control Window............................................................................................... 21

D-Pro Player.............................................................................................................. 22

Main Window Reference............................................................................................... 23

Window buttons......................................................................................................... 23

Terminal..................................................................................................................... 23

Command line prompt............................................................................................... 23

File menu................................................................................................................... 23

File → New show................................................................................................................... 23

Page 2



File → Open show..................................................................................................................23

File → Save show as............................................................................................................. 24

File → Close show................................................................................................................. 24

File → Open recent show...................................................................................................... 24

File → DMX USB PRO Mk2 standalone mode... ...................................................................25

Preferences window.................................................................................................. 26

General tab............................................................................................................................ 26

DMX Outputs tab....................................................................................................................28

Receiving MIDI input from a PRO Mk2 box...........................................................................28

Audio/MIDI tab....................................................................................................................... 29

Remote Control tab................................................................................................................30

Device Browser Reference............................................................................................ 33

Grid tab...................................................................................................................... 33

Physical tab............................................................................................................... 34

edit mode → Enable layout mode..........................................................................................34

edit mode → Layout selected as (submenu) ......................................................................... 34

edit mode → background.......................................................................................................35

edit mode → configure beams...............................................................................................35

List tab....................................................................................................................... 36

Highlight mode...........................................................................................................36

Creating and using groups........................................................................................ 36

Monitor live output..................................................................................................... 36

Programmer Window Reference................................................................................... 37

Basic programming technique................................................................................... 37

Blind mode.................................................................................................................37

Cuelist Editor Reference................................................................................................38

Adding & deleting cues.............................................................................................. 38

Modifying cue data.................................................................................................... 38

Quickly navigating to the programmer....................................................................... 38

Page 3



Editing cue data......................................................................................................... 38

Using the timeline...................................................................................................... 39

Audio events.............................................................................................................. 39

Advanced timings...................................................................................................... 39

Show Control Reference............................................................................................... 40

Populating the show control window......................................................................... 40

Changing the tab names........................................................................................... 40

Changing button/fader names................................................................................... 41

Adding triggers.......................................................................................................... 41

Changing fade times for buttons & sliders................................................................. 41

Adding momentary (flash style) buttons.................................................................... 42

Adding radio groups.................................................................................................. 42

Radio group “round robin” buttons.............................................................................42

Adding override behaviour.........................................................................................43

Using the timeline...................................................................................................... 43

Audio events playback...............................................................................................43

Tap tempo & FX Resync explained........................................................................... 44

Snapshots Panel....................................................................................................... 45

Configuring the snapshot panel ............................................................................................. 45

Saving a new snapshot..........................................................................................................45

Overwriting an existing snapshot...........................................................................................45

Deleting one or more snapshots............................................................................................45

Changing the grid position of snapshots ................................................................................45

Assigning an external controller to a snapshot ......................................................................46

Patch Fixtures Reference.............................................................................................. 47

Patching a new fixture............................................................................................... 48

Deleting patched devices.......................................................................................... 48

Moving a patched device to a new DMX address or universe...................................48

Customising device names........................................................................................48

Page 4



Importing new fixtures............................................................................................... 49

Command Line Reference.............................................................................................50

General guidance:..................................................................................................... 50

Selecting devices.......................................................................................................50

Creating groups......................................................................................................... 51

Editing cues & palettes.............................................................................................. 51

Editing cuelists...........................................................................................................52

Patching simple devices (single channel DMX dimmers)..........................................53

Parking DMX addresses............................................................................................ 53

OSC Reference............................................................................................................. 54

Show Control general................................................................................................ 54

Show Control buttons................................................................................................ 55

Show Control faders.................................................................................................. 56

Show Control snapshots............................................................................................57

Revision History.............................................................................................................58

Release 1.8............................................................................................................... 58

Release 1.7............................................................................................................... 58

Release 1.6.2............................................................................................................ 59

Release 1.5.6............................................................................................................ 59

Release 1.5.3............................................................................................................ 60

Release 1.5.2............................................................................................................ 60

Release 1.4.2............................................................................................................ 61

Release 1.3.1............................................................................................................ 62

Release 1.3.0............................................................................................................ 63

Release 1.2.2............................................................................................................ 65

Release 1.2.1............................................................................................................ 65

Release 1.2.0............................................................................................................ 66

Release 1.1.0............................................................................................................ 66

Page 5



D-PRO SOFTWARE LICENSE AGREEMENT

Before installing the D-Pro software, please carefully read and agree to the following legal 
agreement.  From here on the "Software" refers to the D-Pro Lighting Control Software product in 
whole or in part, including all files, data and documentation.  By installing the Software, you are 
consenting to be bound by and become a party to this agreement.  If you do not agree to all of the
terms of this agreement do not install the Software.

D-Pro Lighting Control Software
END USER LICENSE AGREEMENT

1. Copyright Notice

The Software is © Copyright 2011-2018 DB AUDIOWARE LIMITED, all rights reserved, and is 
protected by United Kingdom copyright laws, international treaties and all other applicable national
or international laws.  The sole owner of this software product is DB AUDIOWARE LIMITED.

2. License Agreement

GRANT.  With respect to each D-Pro software license owned by you, DB AUDIOWARE LIMITED 
grants you a non-exclusive right to install and use the Software on one computer.  You may copy 
the Software for personal archival purposes only.

TITLE.  Title, ownership rights, and intellectual property rights in and to the Software shall remain 
in DB AUDIOWARE LIMITED.  This agreement does not include the right to copy or sublicense 
the Software and is personal to you.

DISCLAIMER OF WARRANTY.  The Software is provided on an "AS IS" basis, without warranty of
any kind, including without limitation the warranties of merchantability, fitness for a particular 
purpose and non-infringement.  The entire risk as to the quality and performance of the Software 
is borne by you.  Should the Software prove defective in any respect, you and not DB 
AUDIOWARE LIMITED assume the entire cost of any service and repair.

HIGH RISK ACTIVITIES.  The Software is not fault-tolerant and is not designed or intended for 
use in environments requiring fail-safe performance.  DB AUDIOWARE LIMITED expressly 
disclaims any express or implied warranty of fitness where the Software is used in any such 
environments.

LIMITATION OF LIABILITY.  UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, 
TORT, CONTRACT, OR OTHERWISE, SHALL DB AUDIOWARE LIMITED OR ITS SUPPLIERS 
OR RESELLERS BE LIABLE TO YOU OR ANY OTHER PERSON FOR ANY INDIRECT, 
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER INCLUDING,
WITHOUT LIMITATION, DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, 
COMPUTER FAILURE OR MALFUNCTION, OR ANY AND ALL OTHER COMMERCIAL 
DAMAGES OR LOSSES. IN NO EVENT WILL DB AUDIOWARE LIMITED BE LIABLE FOR ANY 
DAMAGES IN EXCESS OF THE PURCHASE PRICE OF THE PRODUCT, EVEN IF DB 
AUDIOWARE LIMITED OR ANY IF ITS AUTHORISED RESELLERS SHALL HAVE BEEN 
INFORMED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER
PARTY.

LIMITATIONS ON USE.  You may not use, copy, modify, translate, sell, or transfer the Software or 
any copy except as expressly defined in this agreement.  You may not attempt to unlock or bypass
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any copy-protection or authentication algorithm utilised by the Software.  You may not modify, 
translate, reverse engineer, decompile or disassemble the software (except and solely to the 
extent an applicable statute expressly and specifically prohibits such restrictions), or create 
derivative works based on the Software.  You may not redistribute the Software without the prior 
consent of DB AUDIOWARE LIMITED.

TERMINATION.  Either party may terminate this agreement immediately in the event of default by 
the other party.  Upon any termination of this agreement, you shall immediately discontinue the 
use of the Software and shall uninstall the Software and Documentation and all copies thereof.

GOVERNING LAW.  The laws of Scotland govern this Agreement, and shall govern any dispute 
relating to this Agreement.  The application of the United Nations Convention on Contracts for the 
International Sale of Goods is expressly excluded.

MISCELLANEOUS.  This agreement represents the complete and exclusive statement of the 
agreements concerning this license between the parties and supersedes all prior agreements and 
representations between them.  It may be amended only by a writing executed by both parties. If 
any provision of this agreement is held to be unenforceable for any reason, such provision shall 
be reformed only to the extent necessary to make it enforceable, and such decision shall not 
affect the enforceability (i) of such provision under other circumstances or (ii) of the remaining 
provisions hereof under all circumstances.  Headings shall not be considered in interpreting this 
agreement.

D-Pro EULA Rev.080118

ACKNOWLEDGEMENTS

• D-Pro software (including all component programs, graphics and this documentation) is 
copyright © 2011-2018 DB AUDIOWARE LTD.

• Apple, the Apple logo and Mac are trademarks of Apple Computer, Inc., registered in 
the U.S. and other countries. 

• Windows is a registered trademark of Microsoft Corporation in the United States and 
other countries.

• All other product and company names are trademarks or registered trademarks of their 
respective holders. 
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WELCOME!

D-Pro is a flexible DMX lighting control application for Windows and MacOS computers. D -Pro is 
both easy to learn and use (making it suitable for smaller installations with less demanding 
requirements) while being advanced enough to satisfy the demands of multiple-universe 
theatrical, live event and architectural applications.

This manual contains installation instructions, a quick overview of the workflow (how the various 
windows relate to each other) and a detailed reference for every feature. Please also see the 
training videos available at www.dmxis.com and the inline help available from the “?” buttons 
within the software itself.

D-PRO LICENSING SCHEME – 8 UNIVERSE LICENSE

Your D-Pro license is stored permanently on a Unikey USB dongle, which was provided with your 
purchase. You can install the D-Pro software on as many computers as you wish, but you need to 
insert your Unikey license into a spare USB socket in order to run the software and generate DMX
output.

When you run D-Pro for the first time, you need to activate your Unikey license. This one-off 
exercise requires an internet connection. Once activated, you can use your D-Pro Unikey license 
on any computer without restriction.

D-PRO LICENSING SCHEME – 2 UNIVERSE LICENSE

Your D-Pro 2U license must be activated on first use. The activation process requires an internet 
connection, and will unlock D-Pro 2U on one computer only. 

You can transfer your D-Pro 2U license to another computer at any time in the future by 
requesting a transfer authorisation from support@enttec.com. Note that if you want to run D-Pro 
2U on multiple computers simultaneously, you will need a separate license for each computer.
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INSTALLING D-PRO (8 UNIVERSE UNIKEY DONGLE)

Mount the D-Pro CD on your computer, and navigate to the contents.

Now, double-click on the installer (install-windows.exe or install-mac.pkg as appropriate) and 
follow the instructions.

After installation, insert your Unikey dongle into a spare USB socket and run D-Pro. (You will see  
the D-Pro (full version) icon on your Windows Desktop or the D-Pro icon in the main OSX 
Applications folder). When you first run the application, you will be asked to activate your USB 
license key. 

Fill your name and email into the dialog box and click 'Next'. You will then be asked to confirm 
your details:

Click Yes, and your activation is complete. From this point onwards, your USB license key will 
work in any computer without any restrictions. 
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INSTALLING D-PRO 2U (LICENSE NUMBER)

When you purchased D-Pro 2U, you will have received a license containing your serial number, 
and download links for the software. First, download the software (for OS X or Windows) then run 
it and follow the instructions.

After installation, run D-Pro 2U. (You will see the D-Pro 2U icon on your Windows Desktop or the 
D-Pro icon in the main OSX Applications folder). When you first run the application, you will be 
asked to enter your serial number, name and email address. 

Enter your details and click Next. You will then be asked to confirm that your email address is 
correct. Please check this carefully - your license will be locked to the email account provided!  

Once you are happy that your details are correct, click Yes, register D-Pro!  Your license will now
be activated via internet, and you will receive an email containing a 6 digit unlock code, to be 
entered into the final screen:

Your software will now be unlocked and ready to use!

Page 10



SELECTING A LANGUAGE

The D-Pro user interface can support multiple languages, selectable from the Help > Language 
menu option. Please check the D-Pro product page at enttec.com for available language packs 
and installation instructions.
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QUICK WORKFLOW OVERVIEW

In this section, we take a whistle-stop tour through the main windows & features of D-Pro, and see
how to create a simple show. 

CREATING A NEW SHOW

When you first run D-Pro, you will see the main window. The buttons along the top are used to 
launch the various other windows for managing the components of your show.

The command line is used for entering text commands - you can view the full command line 
reference by clicking on the “?” button.

The first step is to create an empty show – choose the File>New Show menu option, and specify 
where the show file should be saved. 

In D-Pro, each show is self-contained in a single file.
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PATCHING YOUR LIGHTING FIXTURES

Once you have created an empty show, D-Pro will open the Patch Window. From here, you can 
drag fixtures from the list of manufacturers on the top-left to the correct address on the grid on the 
right.

If you cannot see the fixture you need, Get new fixtures will connect to the D-Pro online fixture 
database. If your fixture is available, you can directly download it.

If you still cannot locate your fixture, you can create one by logging into fixtures.dmxis.com. Or 
you can contact support@enttec.com for assistance.

If you want to download a private fixture (i.e. one that you have not shared with the community at 
fixtures.dmxis.com) simply enter your login details when prompted. If you only want to download 
public fixtures, you can dismiss the login window.
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DEFINE THE DMX HARDWARE

Before finally starting on the lighting design, you need to tell D-Pro what hardware you are using 
for this show. Choose the File->Preferences menu option, then the DMX Outputs tab. 

Click on Add New and double-click on the new line that appears in the table. You can then edit 
the output definition to route any one of the 8 universes to an Enttec device (USB Pro, RDM Pro 
or DMXIS box), any two universes to a PRO Mk2 box, or multiple universes to Art-Net:

This example shows that Universe 1 data will be transmitted to the first available DMX USB Pro 
box that is detected.

Note that you can mix & match the outputs – for example output Universe 1 to a PRO box, and 
Universe 2 to Art-Net. 
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THE DEVICE BROWSER AND LIBRARY WINDOWS

Now we're ready to start creating our show. First, you'll notice that two new windows have opened
- the Library and the Device Browser.

The Library is where you can access all the building blocks of your show – groups, palettes, cues
and cuelists.

The Device Browser displays you all your patched fixtures, along with their current level, RGB 
colour and Pan/Tilt values. It is also the window where you select devices for editing.

The Device Browser has 3 tabs, which simply display your fixtures in 3 different ways:

• Grid displays fixtures as a compact grid of cells, and is particularly useful if you have 
lots of conventional fixtures (i.e. simple dimmer channels). You can customise the grid 
layout from the Preferences window.

• Physical displays fixtures as a 2-dimensional plan. Click the edit mode button, and 
position the fixtures to reflect their actual physical layout. This view lets you intuitively 
select fixtures based on their physical location in your rig. And since the icons also 
indicate the level, colour and pan/tilt value of each fixture, it is useful for gaining an 
overview of the current look. 

• List displays the fixtures as a simple flat list. (No attribute values are reflected in this 
tab, it is purely a simple list for selecting fixtures)
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CREATING GROUPS

It is possible to design a show without using groups – you can just directly select fixtures in the 
Device Browser. However, groups are a useful building block that can save you lots of 
programming time when you later add/remove devices from your rig.

A group is just a short-cut to a list of fixtures. For example, you could select all your parcan 
dimmers on stage left and save it as a group called “Stage Left PARs”. You then use this group for
building cues, rather than specifying device numbers. The advantage of this approach is that if 
you need to add more dimmers to stage left, you can simply add them top the group, and all cues 
or palettes using that group will automatically update to include the new dimmers.

To create a group, simply highlight the fixtures in the Device Browser, then click the save group 
button and enter a name (and an optional reference number and subfolder).
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CREATING CUES AND PALETTES

In D-Pro, a palette is a building block used to assemble full cues. Like groups, palettes are a 
useful mechanism to speed up programming and ease maintenance. A palette will typically 
contain all the “reusable” elements of your show, for example the position of a set of movers or a 
particular combination of colours. If you find at the start of your show that some fixture positions 
have changed, you simply edit the position in one palette, instead of editing many cues.

Palettes and cues are built in exactly the same manner, using the Programmer window. The 
Programmer records any changes you make to attributes in the order you made them. You can 
also add multiple effects (chases, fans etc.) to the palette or look.

To create a palette/cue:

• Open the Programmer from the main window.

• Select devices (manually in the device browser or by double clicking on a group in the 
library).

• Modify any attributes in the left hand column of the programmer.

• Repeat as necessary and save as cue or save as palette.

To edit an existing palette or cue, simply double-click on it from the library to load it into the 
programmer.

To use a palette to build a cue, simply drag the palette from the library into the programmer. If you 
have selected some devices before doing this, the palette will only be applied to those specific 
devices.
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CUELISTS

A cuelist is an ordered collection of cues with timing information. In a theatrical setting, a cuelist 
could contain all the cues for the show, in correct order, to be fired manually (for example via the 
space bar). For an architectural display, a cuelist could be set up to run automatically on a loop. 
Later on, we will see how to use the Show Control window to mix multiple cuelists in realtime.

The D-Pro cuelist editor window is activated from the main window. You add cues into the cuelist 
by dragging them in from the library window. 

The timeline shows a graphical representation of the cuelist, along with the controls for playing, 
pausing and advancing through the cues manually. To zoom in & out of the timeline, use the +/- 
buttons or the mouse wheel.

Double-click on any cell to edit the contents. You can also use the mouse wheel to adjust  
selected timing data. Timing data can also be edited by dragging directly on the handles in the 
timeline.

To edit multiple cells, first select them using the shift key, then double-click (while keeping shift 
held down).

Audio Events

The cuelist window also has an audio track (click on “show audio track”). This allows you to drag 
audio files onto the cuelist - to playback audio effects synchronised to a lighting cue, or to sync 
some background music to a light show. (D-Pro supports WAV, AIFF, Ogg Vorbis, FLAC and CAF 
audio file formats)
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DMX OUTPUT WINDOW

This window is activated from the main window, and displays a realtime map of the current values 
of every DMX channel being generated by D-Pro. It is useful as a debug tool.
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SHOW CONTROL WINDOW

The Show Control window is launched from the main window. It is the place from where you run 
your finished show, by clicking on buttons or moving faders to activate cues & cuelists. There is 
also a Grand Master fader to alter the overall level of the show, and a Speed control to alter the 
playback speed of cuelists and any effects in the cues.

To add a cue or cuelist to the Show Control, drag it in from the Library and drop it on a blank fader
or button.

You can right-click (or click & hold from a touchscreen) on a button or fader to edit various 
properties, including the name, fade in/out times, the start trigger and the radio group.

Buttons & faders can be remotely activated from keyboard shortcuts:

• Right click in the button/fader and click Start trigger

• Select Click to learn and press any key on the keyboard.

• Click OK and close the properties window.

In the full version of D-Pro, you can also remotely activate the Show Control window from MIDI 
control surfaces and Enttec hardware wings.
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D-PRO PLAYER

The D-Pro Player is a simplified app for running your final D-Pro show design. It displays only the 
Show Control window, maximised to the available screen space. No editing is possible in the 
player (e.g. Show Control buttons cannot be dragged, and fade times cannot be modified)

The D-Pro Player is ideal for use in permanent installs such as bars & restaurants, where the end 
users may not be lighting experts. In this scenario, you (the lighting designer) would create the 
show using the full D-Pro program, and then leave only the “D-Pro Player” icon available to the 
user on the Desktop. You might also want to configure the computer to auto-start the D-Pro Player
when powered on.

In this way, you can set up a really simple interface for your end-customers. The Preferences > 
General > Show Control Window options can be used as necessary to limit the functionality of the 
Player, even simplifying it down to a single page of push buttons.

By default, the D-Pro Player loads the most recent show that was edited in the full D-Pro 
application.
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MAIN WINDOW REFERENCE

WINDOW BUTTONS

Each D-Pro window has a corresponding button at the top of the main window. Click on these 
buttons to show or hide the windows.

TERMINAL

Under the window buttons is the terminal area. In here, you will see diagnostic and error 
messages relating to the current D-Pro session. Command line activity, and any output generated 
by Python FX scripts is also displayed here.

COMMAND LINE PROMPT

Under the terminal is the command line prompt where you can enter text commands. You can 
press the “Esc” key at any time to automatically switch focus to the prompt.

The “?” button displays an on-screen summary of of the command line language. Also see page
49 for a full command line language reference.

FILE MENU

File → New show... 

Creates a new, empty D-Pro show file. You are first prompted to save & close the current show. 
Then you must specify the name of the new show file. (Each D-Pro show is self contained in a 
single file with a .dsf file extension e.g. “My Show.dsf”)

File → Open show... 

Prompts you to open an existing show file. If necessary, you are first prompted to save & close the
current show.  
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File → Save show as...

Saves a copy of the current show to a new file. You are first prompted to save & close the current 
show. Then you must specify the name of the new show file. If the operation is successful, the 
newly-saved file will then be open in D-Pro.

File → Close show

Closes the current show (prompting you to save any changes first if necessary). Following this 
operation, only the main window will be open.

File → Open recent show 

Allows you to quickly open a recent show file. If necessary, you are first prompted to save & close 
the current show.  
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File → DMX USB PRO Mk2 standalone mode...

You can export any D-Pro cuelist to a PRO Mk2 box, and then run that show in standalone mode 
i.e. without a computer being connected. This is an excellent option for installing permanent 
lighting displays for retail & architectural installs.

Connect the PRO Mk2 to your computer, and click the top button to establish a connection. The 
“Show name” and other fields will display any standalone show currently loaded in that box.

To download a cuelist to the box:

• Select the desired cuelist under “Available cuelists”

• Configure the “Delay before looping”, “Loop count”, “DMX port” and “Play show at 
power on” options as required

• Click “Download cuelist”.

The cuelist will then be automatically downloaded using the maximum possible quality. (Higher 
quality = smoother cuelists & dynamic effects).

Note that longer cuelists will take several minutes to transfer into the PRO Mk2.

A limited amount of memory is available in the PRO Mk2 for standalone shows. If your cuelist 
contains many long crossfades & dynamic FX, the download may fail, or the quality may be poor 
(i.e. the resolution of the crossfades would be rough looking). In this case, reduce the complexity 
of your cuelist by using shorter crossfades, simpler FX (e.g. using squarewave oscillators instead 
of sinewave oscillators) or reduce the number of DMX channels you have patched in the show.
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PREFERENCES WINDOW

The preferences window is accessed from the File → Preferences menu option. From here, you 
can customise the appearance of D-Pro, configure the DMX outputs (USB hardware & Art-Net), 
configure your audio hardware, and customise the remote control features of D-Pro. 

General tab

Small/large font size – changes the primary font sizes used in the D-Pro interface

Show Control font size – changes the font size of all objects on the Show Control window.

Interface colour & Interface contrast – these change the window colour scheme. The new scheme
is displayed instantly as you change the colour selection.

Show Control Window section – this lets you customise the number of buttons, sliders and tabbed
pages in the Show Control window. You can also show/hide the major panels.
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(Grid) Devices per row – changes the number of devices that are packed into one row in the 
“Grid” tab of the device browser. Useful if you have a large rig of traditional dimmer channels,  
plenty of screen space (or multiple monitors) and want to display every dimmer clearly in the grid 
tab.

(Physical) Show beams – allows you to enable or disable the “simulated light beans” in the 
“Physical” tab of the device browser.

Cuelist Behaviour/ Play new cue immediately – this allows you to choose whether the new cue 
should be played immediately, or if the cuelist should pause when using the cuelist next/prev 
buttons (or when activating cuelist next/prev via remote control).

OSC Remote Control / Enable OSC – this enables communications (both send & receive) with an 
OSC controller on the network.

OSC Remote Control / Receive port – this is the network port number for incoming OSC 
messages.

OSC Remote Control / Transmit to IP address – this is the network address of the remote OSC 
controller device. 

OSC Remote Control / Transmit port – this is the network port number for outgoing OSC 
messages.

Page 26



DMX Outputs tab

D-Pro can transmit DMX data to the following devices:

• Art-Net (Ethernet protocol). This allows you to transmit DMX data to any Ethernet-based
hardware such as Enttec's ODE or Datagate Mk2 products.

• Enttec DMX USB PRO (USB to DMX interface, 1 universe)

• Enttec RDM USB PRO (USB to DMX interface, 1 universe)

• Enttec DMXIS hardware (USB to DMX interface, 1 universe)

• Enttec DMX USB PRO Mk2 (USB to DMX interface, 2 universes)

You can mix and match as needed – for example, output universes 1 thru 4 to Art-Net, universe 5 
to a USB Pro box, and universe 6 to a DMXIS box. Each device you are outputting to is 
represented by a line in this table.

Create one line in the table for each device you want to transmit to (using the “add new” button).

Double-click on a line to open the “Connection Properties” dialog, from where you can configure 
the connection – which universe(s) to transmit, the network settings (for Art-Net connections) or 
the hardware serial number (for USB devices).

For hardware connections, you can leave the serial number empty, and D-Pro will connect to the 
first compatible USB device it can detects. IF you want to use multiple USB devices, you MUST 
enter serial numbers for each connection.

Receiving MIDI input from a PRO Mk2 box

Normally, you would tick items in the “Active MIDI Inputs” section of the Audio/MIDI tab to specify 
which MIDI devices to use. However, while the PRO Mk2 box supports MIDI input, it does not 
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appear as a regular OSX/Windows MIDI device. Instead, you must tick the “Enable MIDI Input”  
option in the Connection Properties window for the device:

Note that when this option is enabled, you can only transmit ONE DMX universe of data from the 
PRO Mk2.

Audio/MIDI tab

This allows you to configure the audio output settings (which are used to play cuelist audio 
events).

The “Active MIDI Inputs” section allows you to select which MIDI devices D-Pro will listen to for 
remote control purposes.
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Remote Control tab

You can remotely control certain features of DMXIS Pro using external control surfaces - including
Enttec Wings, MIDI controllers or your computer keyboard.

Every show includes a standard set of remote control "mappings" (to open/close the various 
D-Pro windows from the keyboard, and setup default templates for the Enttec Program and 
Playback wings) but you can modify or extend these with you own custom mappings. Your 
customisations are stored with the currently loaded show.

A mapping consists of the source device (e.g. the keyboard) and event (e.g. F1), and the resulting
action (e.g. "Show patch window") and an optional parameter.

To create a new mapping

• Click on the "learn new mapping" button.

• Press the desired key or move a slider/knob on your wing, MIDI controller or computer 
keyboard.

• In the dialog that appears, choose the action from the menu, and type in any parameter 
required.
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Available remote control actions

Action name Description Parameter

Type on command line This 
automatically 
enters text onto 
the main window 
command line. 
Use this action 
for firing quick 
macros.

The string to be filled into the command line 
window. (e.g. “GROUP “)

Alternatively, you can choose one of the 
following keyboard shortcuts as the parameter:

<ENTER> : simulates the Enter key being 
pressed on the keyboard. In practice, this will 
execute the command currently in the command
line window.

<UP> or <DOWN> : simulates up/down arrow 
key presses. This will scroll through the history 
of previous commands in the command line 
window.

<LEFT> or <RIGHT> : simulates left/right arrow 
key presses. This will move the insert cursor 
position on the command line window.

<BS> : simulates a backspace key press. This 
will delete the character to the left of the current 
cursor position

By default, the above shortcuts are already 
mapped in every new show to allow an Enttec 
Program wing to be used for command line 
duties.

Switch focus to main window 
(cmd line)

Activates the 
main window, 
and readies the 
command line to 
receive a text 
command.

No parameter

Show/hide library window

Show/hide device browser

Show/hide programmer window

Show/hide cuelist window

Show/hide patch window

Show/hide DMX output window

Show/hide show control

Shows or hides 
the specified 
window.

No parameter

Show Control: Submaster 
Run/Pause

Show Control: Submaster Next

Show Control: Submaster 
Previous

Controls the 
execution of a 
cuelist loaded 
onto a Show 
Control 
submaster slider.

The index number of the submaster slider in the 
Show Control window. For example, if you have 
3 tabs of 10 sliders:

• 1 is the top slider on the first tab

• 12 is the 3rd slider down on the 
second tab

• 29 is the bottom slider on the 3 rd tab
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Show Control: SET GRAND 
MASTER

Show Control: SET SPEED

Show Control: TAP TEMPO

Show Control: RESYNC FX

Show Control: SET TEMPO (60-
187 BPM)

Show Control: RESET OUTPUT

Controls the 
various buttons &
sliders on the 
master strip at 
the bottom of the 
Show Control 
window

No parameter

DMX Output: DIRECT 
CONTROL

Directly controls 
one or more DMX
channels, 
overiding any 
current cues & 
cuelists playing 
on that channel.

An example use 
would be to  
directly control 
Pan/Tilt of a 
moving head 
fixture from a 
MIDI XY 
controller.

A comma-separated list of DMX channels to be 
controlled

DMX Output: CANCEL DIRECT 
CONTROL

Cancels the 
DIRECT 
CONTROL action
above, and 
returns control to 
the active cues &
cuelists

A comma-separated list of DMX channels to be 
controlled. 

Enter “0” to cancel direct control across ALL 
DMX channels.
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DEVICE BROWSER REFERENCE

The Device Browser is the focal point of the entire D-Pro application. It displays the devices 
patched into your show, it allows you to select devices for programming, and it graphically 
displays the values of key attributes (dimmer levels, colours, and pan/tilt values of intelligent 
movers).

Note that when you select devices, the order of your selection is preserved. This is important if 
you are selecting devices in order to apply (for example) a "chase" FX script.

GRID TAB

The grid tab is useful for large rigs with many conventional dimmers. Due to the grid layout, you 
can visualise and select many hundreds of channels easily. You can customise the number of 
devices displayed on each row from the Preferences window.

There are a number of ways to select devices in the grid:

• Click on a device to select it.

• Click on one device, then shift-click on a second device to select that entire range.

• Click and drag to select an arbitrary set of devices

• Ctrl-click to add or remove a single device from the selection

• Ctrl-drag to add an arbitrary set of devices to the selection.

The grid will display the current dimmer level and RGB colour value of all devices currently 
recorded in the current programmer (or of ALL devices in your show when "monitor live output" is 
selected.
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PHYSICAL TAB

The physical tab is a virtual representation of your rig. Each device appears as an icon against a 
customisable background image (which can be a picture of your venue, or a simple CAD sketch of
the rigging). Each icon can throw a customisable “virtual beam” of light as a simple visualisation 
tool. The colour & brightness of the icons and virtual beams reflect the actual DMX values being 
transmitted to the hardware. 

You can position your fixtures to reflect their position in the physical lighting rig. This makes 
complex selections very easy, and lets you visualise (in a simple 2-D manner) the overall look of 
the current programmer contents (or the entire rig when "monitor live output" is enabled).

As well as displaying the dim levels and RGB colour values, the physical tab will also display the 
current pan/tilt position of any movers, using simple "virtual beams". It's important to note that the 
virtual beams do not necessarily represent the actual beam projected by the device, as they do 
not take account of orientation or degrees of movement. However, the virtual beams are an 
excellent visual confirmation that (for example) an FX script is performing as you expect.

Selection of devices in the physical tab is the same as for the grid tab (see above for details).

edit mode →  Enable layout mode

When this is enabled, you can select and reposition fixtures against the background by dragging 
them. You can also change the zoom level using the slider at the top-left of the window. This 
allows you to fit more or fewer fixtures into the screen space available.

edit mode → Layout selected as (submenu)

This submenu contains a number of automatic layout options, which will affect the currently 
selected devices. For example, to lay out 4 devices in a horizontal line:

• Select devices 1-4 

• Choose Layout selected as → horizontal line
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The devices will be arranged in the order you select them. For example, if you want the devices to
appear horizontally as 1 3 4 2, then select the devices in that order (using Ctrl-click key) before 
running the layout command.

edit mode → background

Select “Set background image...” then choose any image file. This file will become the background
of the physical tab. When you resize the device browser window, the background image is scaled 
to fit.

Select “Remove background image” to revert to the normal plain background.

Grayscale photos of your venue or installation work best as background images, as the coloured 
virtual beams will appear more clearly with greater contrast. It can also be useful to use a simple 
2D CAD drawing of the rig as a background.

edit mode → configure beams

Every patched fixture in your rig – even plain dimmer channels – can display a virtual beam in the 
browser window. As the screenshot on the previous page shows, this is extremely useful for basic 
visualisation of fixed devices. 

The “Beam Properties” window lets you modify the virtual beam properties of the currently 
selected devices. For example, let's assume devices 4-6 are regular parcans with a blue gel. 
Here's how to configure the virtual beams:

• Select “edit mode → configure beams” to open the Beam Properties window.

• Select device icons 4-6 

• Drag the Power/Direction/Beam sliders as desired, so that the beam direction, width & 
distance looks correct.

• Select the desired shade of blue in the colour selector (to match the real gel colour)
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LIST TAB

In the list tab, all devices are displayed as a simple flat list. Devices can be selecting by clicking, 
shift-clicking or ctrl-clicking. This tab does not display any attributes such as dimmer levels.

HIGHLIGHT MODE

When highlight mode is enabled, any selected fixtures will immediately illuminate. This is 
particularly useful during setup & rigging - it lets you quickly activate fixtures for focusing, and lets 
you verify that the lamps are functioning or that devices have been physically addressed correctly 
(without using the programmer window).

Highlight mode is also helpful if you are designing cues/palettes which only contain position 
information. Activating highlight mode will let you see the beam positions without actually 
recording any dimmer or colour levels.

Note that highlight mode depends on "highlight" information being present  in the fixture definition. 
If you find that highlight mode is not working, then you should log into fixtures.dmxis.com and 
verify that the highlight values are defined.

CREATING AND USING GROUPS

You can save the current selection of devices at any time by clicking on "save group". We highly 
recommend that you use groups for programming cues & cuelists, rather than manually selecting 
the devices each time.

All of your groups are displayed in the library window. You can create unlimited numbers of groups
and organise them into any number of folders in the library window.

To use a group for programming, simply double-click on the group name in the library window. 
That group will then be highlighted in the Device Window. Now, when you edit attributes or add FX
in the programmer, you will see the group name displayed in the programmer.

MONITOR LIVE OUTPUT

This feature is available in the grid and physical tabs only. It shows you a live preview of the DMX 
data currently being transmitted by D-Pro.
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PROGRAMMER WINDOW REFERENCE

The Programmer Window is where you design all the looks for your show. Looks can be either 
static, or can contain dynamic elements (such as colour chases, shutter chases, moving head 
effects). Once you have finished designing each look, you can either save it as a cue or a palette.

Cues can be loaded directly into the Show Control window, or can be used for building cuelists.

Palettes can be thought of as building blocks, which are used to construct complex looks.

BASIC PROGRAMMING TECHNIQUE

The programmer window has two main areas:

• On the left is the editor panel (where you see device attributes & FX settings) 

• On the right is the recorder.

As you create your look by changing attributes or adding FX, you see each change being added 
to the recorder. You can click on any line in the recorder to go back to that step and edit it (or 
delete it completely using the "delete" button).

To edit an attribute (for example, the dimmer level of some fixtures)

• Highlight the fixtures in the device browser (by manual selection or double-clicking a 
group in the library)

• The attributes for those fixtures appear in the left panel. (If you select mixed fixtures, 
you will only be able to edit the dimmer levels)

• Modify the attributes as required in the editor panel. You see your changes appearing in
the recorder.

To apply an effect script (for example, make some intelligent fixtures move in a circle)

• Highlight the fixtures in the device browser (by manual selection or double-clicking a 
group in the library)

• Click "add effect" in the programmer, and select the FX script you want (e.g. 
Shapes->Circles)

• Modify the FX parameters in the editor panel.

You can add unlimited numbers of effects as required.

BLIND MODE

When blind mode is activated, the changes made in the programmer will NOT be transmitted to 
the DMX output hardware. This is useful for making changes on-the-fly without affecting the look 
on stage. Note that the device browser will still display the dimmer, RGB and pan/tilt values - but 
they will not be actually transmitted.
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CUELIST EDITOR REFERENCE

The cuelist window allows you to assemble multiple cues into a timed performance. The show 
control window allows you to run multiple cuelists simultaneously, but in many cases you may find 
that a single cuelist is all you need to run an entire show.

ADDING & DELETING CUES

To add a cue, simply drag it in from the library window. You can insert the cue at a specific point in
the cuelist by dropping it in the middle of the table.

To delete a cue, highlight it in the table and click "delete..." button

MODIFYING CUE DATA

To modify any of the data in the table, simply double-click on a cell. You can modify multiple cells 
data simultaneously. For example, to change the start trigger across all cues:

• Click Start trigger in first cue

• Shift-click Start trigger in the last cue (now all cues are selected)

• Double-click on Start trigger in the last cue while holding down shift.

You can modify highlighted In/Hold/Out times by using the mouse wheel, or by dragging on the 
yellow handles directly in the timeline.

All edits made in the cuelist are temporary - until you click on save or save as cuelist to record 
your changes into the show.

QUICKLY NAVIGATING TO THE PROGRAMMER

If you need to make a quick modification to a cue while in the cuelist editor, highlight the cue in the
table and click the edit cue button. This will open that cue in the programmer window.

EDITING CUE DATA

The Cue No column contains the cue numbers, in the format X.Y. Default cue numbers are 
allocated when you drag in cues - however, you can edit them manually if for example you are 
working to a script with published cue numbers.

The Description column is the label that is displayed for that cue in the timeline. By default it is the
cue name, but can be modified as desired.

The Start trigger is optional. This is the external hardware event (from the keyboard, a MIDI 
controller or an Enttec wing) that will trigger the cue. For example, if you want to manually 
advance through the cuelist from the spacebar:

• Shift-select "Start trigger" cells, then double-click (while holding the shift key)

• In the Keyboard tab, select "Click to learn" and press the spacebar.
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• Press OK.

You will now see "spacebar" as the trigger for every cue in the cuelist.

The Action while done column is by default "Run next cue". In this mode, the cuelist will run & loop
forever. You can optionally change any cue to "Stop cuelist", which will effectively give you a "one-
shot" cuelist.

The timing columns are used to control the fade in/out & hold time of each cue. 

USING THE TIMELINE

Zoom in & out of the timeline using the +/- buttons, or the mouse wheel 

Run & pause the cuelist with the green go button.

The first click of the stop button will fade out the cuelist (using the fade out time of the cue 
currently playing). A second click of the button will force the cuelist to stop playing immediately.

Use the < and > buttons to move to a different cue in the cuelist.

The current status of the timeline (idle, running, fading out, waiting for trigger) is displayed on the 
top right.

AUDIO EVENTS

You can enable the show audio track button, and then drag audio files into the timeline for 
synchronised playback along with your cuelist. Audio events can be precisely positioned by 
dragging on the audio file in the timeline. 

To delete an audio event, highlight it on the timeline and click delete.

If you play back multiple cuelists in the show control window simultaneously, the audio files will be 
mixed together in realtime, synchronised to the multiple cuelists.

D-Pro natively supports wav, AIFF, CAF, Ogg Vorbis and FLAC audio files formats, along with any 
audio format supported by the underlying OS X CoreAudio or Windows DirectShow libraries. At 
the time of writing, both these libraries support mp3 playback.

ADVANCED TIMINGS

Say you want a cue to fade up the dimmer level over 5 seconds, but you want the pan/tilt values 
to fade up over 1 second:

• Set the "In" cell for the cue to 5.00.

• Click on the "advanced timings" button and select Position

• Three new columns appear in the table.

• Set the "Pos:In" cell for the cue to "1.00".
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SHOW CONTROL REFERENCE

Show Control is the top-level window used to execute your finished show. Typically, after creating 
a bunch of cues & cuelists, you drag them onto the buttons/sliders of the show control window, 
maximise it, and run the whole show from there. 

It consists of a grid of buttons and a column of faders (the actual quantity of which can be 
customised in Preferences), two global sliders for changing grand master (i.e. the overall rig dim 
level) and speed (of the cuelist playback and FX). 

Finally, when you run one or more cuelists, their timelines will be displayed in realtime at the 
bottom of the window.

You can simply use your mouse to drive the show control buttons & sliders - however there are 
some nice alternatives:

You can program each button & slider to be triggered from the computer keyboard, a MIDI 
controller and/or any Enttec hardware wing. 

The show control window is designed to be very usable when combined with a standard 
touchscreen. 

Using an iOS app such as iDisplay, you can use an Apple iPad to run the show (if you are happy 
with the risks limitations of using WiFi technology in a live performance!)

New in release 1.7 – The snapshot panel lets you record the full Show Control state onto buttons,
for fast programming & recall of full looks.

POPULATING THE SHOW CONTROL WINDOW

To load cues or cuelists onto buttons or faders, simply drag them in from the library window.

To clear buttons, faders & snapshots:

• Click the config button (gear icon) to go into config mode. The Properties window 
appears.

• Select the buttons & sliders you want to clear (using shift key if necessary).

• Click "Reset" and then "Yes".

• Click the config button (gear icon) to exit config mode.

Buttons can be repositioned simply by dragging & dropping (while in config mode).

CHANGING THE TAB NAMES

Right-click on any tab to edit its name.
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CHANGING BUTTON/FADER NAMES

By default, the label on a button or fader is the same as the loaded cue or cuelist. To edit the 
button/fader name:

• Click the config button (gear icon) to enter config mode. The Properties window 
appears.

• Click on the button, fader or snapshot button to highlight it.

• Edit the first field in the Properties window to contain your custom label.

• Repeat as required for other buttons, faders or snapshot buttons.

• Click the config button (gear icon) to exit config mode.

ADDING TRIGGERS

You can trigger buttons, faders & snapshots from a variety of controllers as follows:

• Click the config button (gear icon) to enter config mode. The Properties window 
appears.

• Click on the button, fader or snapshot button to highlight it.

• Click on "Start trigger". The Trigger Properties window appears.

• Click on the tab (Keyboard | MIDI | Enttec Wing) you want to use.

• Select "Click to learn" and move/press the keyboard or control on the hardware.

• Click OK to close Trigger Properties

• Repeat as desired for other buttons & sliders.

• Click the config button (gear icon) to exit config mode.

Now the buttons & faders will display their triggers above the label.

New in release 1.7 – if you highlight multiple buttons/sliders and learn from a MIDI controller, you 
will be asked if you want to trigger those buttons/sliders using a range of MIDI Notes or CCs.

For example, say you highlight 8 buttons in edit mode, click to learn, and send MIDI Note 20. You 
will then be able to trigger the 8 buttons using MIDI Notes 20,21,22...27. 

CHANGING FADE TIMES FOR BUTTONS & SLIDERS

You can modify the fade in & out time of all buttons & sliders. This work for both cues & cuelists:

• Click the config button (gear icon) to enter config mode. The Properties window 
appears.

• Select the buttons & sliders you want to clear (using shift key if necessary)

• Drag the "fade in" and "fade out" sliders to the desired value (or click and type a value in
seconds)

• Click the config button (gear icon) to exit config mode.

Note that fade times cannot be defined for snapshot buttons. 
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ADDING MOMENTARY (FLASH STYLE) BUTTONS

Buttons can either latch on & off (default mode) or behave like flash buttons on a traditional 
console (momentary mode). To activate momentary mode:

• Click the config button (gear icon) to enter config mode. The Properties window 
appears.

• Select the buttons you want to modify (using shift key if necessary)

• Enable the “Momentary” button to change those buttons to flash mode.

• Click the config button (gear icon) to exit config mode.

Momentary (flash) buttons can be identified by a small arc in the lower left corner.

Note : you cannot have momentary buttons in a radio group.

ADDING RADIO GROUPS

Sometimes you will want buttons to behave in a "radio box" manner - that is, only one button can 
be active at any time. For example, you might have "Red", "Yellow" and "Green" cues, which 
control the colour of your whole rig. You don't really want to MIX these cues, so the radio box is 
the answer:

• Click the config button (gear icon) to enter config mode. The Properties window 
appears.

• Click the “Red”, “Green” and Yellow” buttons (using shift key)

• Use the +/- buttons to set this to "Radio group : 1"

• Click the config button (gear icon) to exit config mode.

Now you will see all 3 buttons highlighted in a different colour (to indicate that they are a radio 
group). When you switch on any button in the group, all others will switch off, with any fade in/out 
times providing a nice smooth crossfade.

RADIO GROUP “ROUND ROBIN” BUTTONS

If you setup an identical trigger on every button in a radio group, then you can automatically 
advance from one button to the next using that trigger. 

For example, say you are using D-Pro to run lighting for a live band, and you have one cuelist with
a backing track for each song. You can load those songs onto Show Control buttons, then set 
them all to belong to the same radio group, and set them all up to trigger from a MIDI Note on a 
keyboard. Now, you can advance through the set simply by bumping the MIDI Note at the end of 
each song. And with easy drag/drop of buttons in the Show Control window, you can quickly 
change the order of the “set”.
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ADDING OVERRIDE BEHAVIOUR

By default, Show Control buttons & sliders behave as follows:

• Dimmer & colour channels fade in & out according to the fade times defined.

• All other control channels snap directly to their target value.

• Colour & dimmer channels are HTP (Highest Takes Priority) behaviour. That is, when 
several cues are currently active, the highest available value for the channel (across all 
active cues) is output.

• Control channels are LTP (Latest Takes Priority). That is, when several cues are 
currently active, the most recently modified value (across all active cues) is output.

Sometimes you may need direct control over some fixture channels, overriding the default 
HTP/LTP behaviour. For example, you may want to directly manipulate a Colour Wheel from a 
fader on the Show Control window. To do this, activate Override for that fader or button:

• Click the config button (gear icon) to enter config mode. The Properties window 
appears.

• Select the buttons & faders you want to modify (using shift key if necessary)

• Enable the “Override” button to change those buttons to override mode.

• Click the config button (gear icon) to exit config mode.

USING THE TIMELINE

As with the cuelist window, you can:

• zoom in & out of the timeline using the +/- buttons, or the mouse wheel.

• run & pause the cuelist with the green go button.

• click the stop button once to fade out the cuelist (using the fade out time of the cue 
currently playing) and a second time to force the cuelist to stop playing immediately.

• use the < and > buttons to move to a different cue in the cuelist.

• see the current status of the cuelist (idle, running, fading out, waiting for trigger) is 
displayed on the top right.

AUDIO EVENTS PLAYBACK

If any of the cuelists playing back have audio events, these will be played in sync with their parent 
cuelists. Multiple audio events from multiple cuelists can be played back simultaneously.

See the help page on the cuelist window for more information about audio events.

TAP TEMPO & FX RESYNC EXPLAINED

You will notice the speed slider is marked in both percentage and musical bpm. You can change 
the relative speed of the cuelists and cue FX by moving this slider, or clicking and entering a new 
bpm figure.
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The tap tempo button next to the speed slider allows you to manually tap in a rhythm, in order to 
match the FX speed with live music. You can tap the tempo using the mouse, or set up a 
keyboard/MIDI/wing remote controller (the event type is “TAP TEMPO” in the Preferences|Remote
Control window).

The FX resync button (to the left of tap tempo) will re-trigger all currently running FX. This is used 
to periodically re-sync the cues with the live music (as they will inevitably drift apart over time).

So, how do you actually create your cues in the programmer to create nice tempo-synced FX? 
Rather conveniently, with a tempo of 120bpm, half a second is exactly 1 beat. So, to create a 
shutter chase that cycles exactly every 8 beats, just set the shutter chase time slider (in the 
programmer FX panel) to 8*0.5s = 4s.

Then, when you adjust (or tap) the tempo in Show Control, the FX will adjust automatically to lock 
to the new tempo.
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SNAPSHOTS PANEL

New in release 1.7

The snapshot panel allows you to quickly save & recall the overall state of the Show Control 
window (i.e. the current state of every button & slider) onto a single button. Snapshot buttons can 
then be used to recall full looks at a single click. This is a very powerful way to design & record 
complex looks during show programming. 

Like normal Show Control buttons, snapshots can be triggered from external MIDI controllers, 
Enttec wings or via the OSC interface.

Configuring the snapshot panel

• Select File > Preferences.

• Under General > Show Control Window, edit the snapshot panel options as required.

• Close the Preferences window and close/open the Show Control window.

Saving a new snapshot

Simply click on any empty snapshot button and enter the name for that snapshot.

Overwriting an existing snapshot

Click & hold on the snapshot button to overwrite it with the current state. You can optionally edit 
the name whilst doing this.

Deleting one or more snapshots

• Click on the Show Control gear icon to enter edit mode.

• Shift-click on the snapshot buttons to highlight them

• Click “Clear” in the Properties window.

• Click the gear icon to exit edit mode.

Changing the grid position of snapshots

• Click on the Show Control gear icon to enter edit mode.

• Drag & drop the snapshots into the positions required.

• Click the gear icon to exit edit mode.
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Assigning an external controller to a snapshot

You can trigger snapshots from a variety of controllers as follows:

• Click the config button (gear icon) to enter config mode. The Properties window 
appears.

• Click on the snapshot button to highlight it.

• Click on "Start trigger". The Trigger Properties window appears.

• Click on the tab (Keyboard | MIDI | Enttec Wing) you want to use.

• Select "Click to learn" and move/press the keyboard or control on the hardware.

• Click OK to close Trigger Properties

• Repeat as desired for other snapshots.

• Click the config button (gear icon) to exit config mode.

Now the snapshots will display their triggers above the label.

 if you highlight multiple snapshots and learn from a MIDI controller, you will be asked if you want 
to trigger those buttons/sliders using a range of MIDI Notes or CCs.

For example, say you highlight 8 snapshots in edit mode, click to learn, and send MIDI Note 20. 
You will then be able to trigger the 8 snapshots using MIDI Notes 20,21,22...27. 
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PATCH FIXTURES REFERENCE

Before you can start programming your light show, you need to tell D-Pro what DMX devices you 
have available to control. This is done from the Patch Window, which is accessed from the toolbar
on the main window:

The top left is the Fixture Library panel, which lists all manufacturers and fixtures that are 
available for patching. These fixture profiles are stored locally on your computer. The “Get new 
fixtures...” button allows you to import extra manufacturers and fixtures into your D-Pro 
installation.

At the bottom left is the Patched Devices panel, which is a list of all fixtures that are patched in the
currently loaded show.

On the right is the patch grid, which shows a visual map of all the patched fixtures and their 
offsets within their DMX universe. 
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PATCHING A NEW FIXTURE

• First, locate the correct manufacturer and fixture in the fixture library. (Note that many 
fixtures have several different operating modes, so be sure to choose the one that 
matches the mode actually selected on your lights.)

• Next, specify the quantity of fixtures that you need to patch in the “Num fixtures to 
patch” field.

• Then select the appropriate universe tab in the grid. (The number of available tabs will 
depend on the version of D-Pro that you own)

• Drag the fixture name to the grid. As you move the pointer, you  see a preview of where 
the devices will be patched. Drop the fixture name to patch the devices

• Finally, you are asked to enter a device number  – do NOT enter the channel number 
where you patched the device! This is an arbitrary number that helps you to identify 
your fixtures while you are programming your show. So choose numbers that will be 
helpful to you - for example you could patch your parcans from 1-20, your scanners 
from 50-60...

DELETING PATCHED DEVICES

To delete one or more patched devices:

• Select the device in the Patched Devices list. Use Shift-click or Ctrl-click to select more 
than one device if necessary.

• Click the delete button and select “Yes”.

The deleted fixtures will disappear from the patch grid and the Device Browser window. However, 
references to the deleted device are NOT deleted from your cues, palettes and cuelists. Thus, you
can delete a device and re-patch it at a later date, and your cues will be unaffected.

MOVING A PATCHED DEVICE TO A NEW DMX ADDRESS OR UNIVERSE

You can modify the DMX universe and address of a patched device by double-clicking on the 
“Patched at” column of the Patched Devices table and entering a new universe and channel 
number.

CUSTOMISING DEVICE NAMES

Each patched device has a custom name (visible in the Patched Devices table). Since these 
names appear in the Device Browser, you probably want to rename the defaults (e.g. “AccuSpot 
250 II:9ch 2/3”) to something more useful like “RGB Left A”. 

To do this, double-click on the custom name in the Patched Devices table and change it.

If you have a logical group of identical fixtures (say 8 pinspots over a drum kit) you can quickly 
rename them in one step as follows:

• Click on the first custom name, then shift-click on the last one (to select all 8).

• With the shift key held down, double-click on the last custom name.

• Enter the custom name (e.g. “Drum Spot”)

Page 47



The custom names of all 8 fixtures will change to “Drum Spot 1” to “Drum Spot 8”.

IMPORTING NEW FIXTURES

A basic fixture library is shipped with D-Pro. More fixtures are available from our online database 
located at fixtures.dmxis.com. You can also create your own customer fixtures, and optionally 
share these with other D-Pro and DMXIS users.

To import a fixture from the online database:

• Make sure you have a live internet connection.

• Click on the “Get new fixtures...” button.

• To import a private fixture that you have created with the online editor, enter your 
username & password then click “Log In”. 

• To import a fixture from the public database, click “No thanks”.

• Locate the manufacturer and fixture required in the tree and click “ Import fixture...”

The selected fixture will be imported from the online database directly into D-Pro, and will 
immediately be available for patching.

Note: if you need to re-import the fixture from the public database again (for example, to grab a 
bug fix to the definition) simply go through the above process again. 

Page 48

http://fixtures.dmxis.com/


COMMAND LINE REFERENCE

GENERAL GUIDANCE:

• You can quickly switch to the command line from any window by pressing the "Esc" key.

• Recall and execute previous commands by using the up/down arrow keys.

• Commands are case insensitive (e.g. "RECORD GROUP 23" and "record group 23" are
identical). 

• Most commands have shorthand versions, see documentation below. (e.g. "RECORD 
CUELIST 100" and "REC CL 100" are identical).

• You can use the Remote Control tab of the Preferences window to record custom 
command line shortcuts, to perform common tasks for specific shows.

SELECTING DEVICES

Type the fixture number to select it in the Device Browser.

Command Meaning

2 Select fixture 2 in the Device Browser

Use "/" to select a range of fixtures

Command Meaning

2/5 Select fixtures 2,3,4 and 5

Use "+" to select multiple fixtures

Command Meaning

2+5+7 Select fixtures 2,5 and 7

Use "-" to unselect fixtures

Command Meaning

2/6 - 4 Select fixtures 2,3,5 and 6
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Type GROUP/G followed by a group number or name in quotes to select that group

Command Meaning

GROUP "Scanners Left" Select fixtures contained in the group named "Scanners Left"

GROUP 23 Select fixtures contained in group 23

CREATING GROUPS

To create a new group, select the required devices in the Device Browser (as described in 
Selecting Devices above) then use the RECORD GROUP command: 

Command Meaning

RECORD GROUP 12 Save current selection as new group number 12

REC GROUP "My Group" Save current selection as new group called "My Group"

EDITING CUES & PALETTES

Select your devices followed by "@" and the level specified as a percentage, fixed DMX value or 
real number. All level changes are recorded into the cue or palette currently open in the 
programmer. (Note that the programmer window must be open before you can change levels). 

Command Meaning

20/30 @ 75 Set dimmer level on devices 20 through 30 to 75%

23 @ 190D Set device 23 dimmer level to 190 (in the DMX range 0-255)

GROUP 12 @ 0.6 Set dimmer level for devices in group 12 to 0.6 (60%)

G "House Lights" @ FULL Set dimmer level for group "House Lights" to maximum.

Quickly set device levels on & off as follows:

Command Meaning

10/15-12/13 ON Turn up devices 10,11,14 & 15 to full.

G 200 OFF Turn all devices in group 200 to minimum level.

Page 50



Nudge device levels up & down (relative to their current level) as follows:

Command Meaning

70 @ +10 Turn up device 70 by absolute amount 10. For example, if the level is 
currently 140 (on the DMX scale 0-255) it will increase to 150.

G 200 @ -5% Turn all devices levels in group 200 down by 5%.

Add FX scripts to the programmer as follows:

Command Meaning

FX "Figure 8" Apply the "Figure 8" FX script to the devices currently selected.

FX "Circles" 75 20 33 Apply the "Circles" FX script, and set the first 3 script parameters to 75, 
20 and 33.

To save the current contents of the Programmer window as a new cue or palette:

Command Meaning

RECORD CUE 33 Save programmer as new cue number 33

REC PALETTE "P 123" Save programmer as new palette called "P 123"

EDITING CUELISTS

To append a cue into the cuelist (currently displayed in the cuelist window):

Command Meaning

ADD CUE 33 Add cue number 33 to the current cuelist

A C "Blue Wash" Add the cue named "Blue Wash" to the current cuelist

To save the current contents of the Cuelist window as a new cuelist:

Command Meaning

RECORD CUELIST 33 Save cuelist window contents as new cuelist number 33

R CL "Sunrise" Save cuelist window contents as new cuelist called "Sunrise"
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PATCHING SIMPLE DEVICES (SINGLE CHANNEL DMX DIMMERS)

To patch one simple device:

Command Meaning

PATCH 50 @ 2:325 Patch a single device (device 50) into DMX address 325 of Universe 2.

To patch a range of simple devices:

Command Meaning

PATCH 150/199 @ 1:300 Patch 50 devices (devices 150-199) into Universe 1, from DMX address 
300 up to DMX address 349.

PARKING DMX ADDRESSES

You can park specific DMX addresses, which will lock those DMX addresses at their current 
values (regardless of what cues or cuelists are currently active). Parked addresses are visible in 
the DMX Output window as e.g. *143*. 

To park and unpark a single address:

Command Meaning

PARK 3:221 Park address 221 in universe 3

UNPARK 3:221 Unpark address 221 in universe 3

To park a range of addresses:

Command Meaning

PARK 1:50/1:60 Park addresses 50-60 in universe 1

UNPARK 1:50/1:60 Unpark addresses 50-60 in universe 1

To unpark all addresses across all 8 universes: 

Command Meaning

PARK CLEAR Unpark all addresses

PARK C Unpark all addresses
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OSC REFERENCE

An OSC controller (such as TouchOSC or Lemur on iOS) can be used to remotely control D-Pro. 
This offers some significant advantages over MIDI, including higher resolution control and visual 
feedback of the D-Pro Show Control settings.

OSC communications are configured from the General tab of the Preferences window, see earlier 
section.

The following tables list all OSC messages that can be sent or received by D-Pro.

SHOW CONTROL GENERAL

Command
Transmit (TX) 
or Receive 
(RX)

Description

/sc/gm [level]

[level] = float from 0.0 to 1.0
TX+RX

Sets the Grand Master level.

e.g. /sc/gm "0.35"

/sc/gm/label [string]

[string] = the current GM level 
represented as a percentage.

TX

A string representing the Grand Master 
level. 

e.g. /sc/gm/label "35.1%"

/sc/speed [speed]

[speed] = float multiplier from 0.25 to 4.0
TX+RX

Sets the global Speed value.

e.g. /sc/speed/label "35.1%"

/sc/speed/label [string]

[string] = the current show speed 
represented as a percentage.

TX

A string representing the Grand Master 
level. 

e.g. /sc/speed/label "35.1%"

/sc/tempo [tempo]

[tempo] = float multiplier from 30.0 to 
480.0

TX+RX

Sets the global Speed value using a 
tempo.

e.g. /sc/tempo “145”

/sc/tap RX
Call repeatedly to set the tempo. 
Equivalent to clicking repeatedly on the 
Show Control 'Tap Tempo' button.

/sc/sync RX
Call to restart any cues with oscillators. 
Effectively, this retriggers any chases.

/sc/reset RX
Call to immediately stop all active cues & 
cuelists. Equivalent to clicking the red 
Show Control 'Reset' button.
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SHOW CONTROL BUTTONS

Command
Transmitted 
or Received 
by D-Pro

Description

/sc/btn/run/t/r/c [state]

t/r/c = tab/row/column of the button

[state] = 0 (stop) or 1 (start)

TX+RX

Start & stop the cue or cuelist on the 
specified button.

e.g. /sc/btn/run/2/4/7 "1"

/sc/btn/label/t/r/c [name]

t/r/c = tab/row/column of the button.

[name] = string containing the button 
name

TX

Sends the name of a Show Control button
to the connected OSC controller.

When the Show Control window is 
opened, this message is sent for every 
button in the window. This allows remote 
OSC controllers to display the real names 
of the Show Control buttons. The 
message is also transmitted when the 
name or position of a Show Control button
is changed.

e.g. /sc/btn/label/2/4/7 "Blue Stage Left"

/sc/btn/speed/t/r/c [value]

t/r/c = tab/row/column of the button.

[value] = float multiplier

RX

Sets the relative speed of oscillators 
running in the cue on this button.

This allows the speed of oscillator-based 
chases to be adjusted on a cue-by-cue 
basis, in addition to the global speed 
control.

e.g. to halve the speed of button on tab 1, 
row 6, col 3: /sc/btn/speed/1/6/3 "0.5"

/sc/btn/phase/t/r/c [phase]

t/r/c = tab/row/column of the button.

[phase] = float between 0.0 and 1.0.

RX

Sets the phase (chase starting point) of 
the cue on this button.

Only affects buttons containing 
cues/cuelists with active oscillators

e.g. start cue at fixture #7 of a 10 fixture 
chase: /sc/btn/phase/2/3/1 "0.7"
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SHOW CONTROL FADERS

Command
Transmitted 
or Received 
by D-Pro

Description

/sc/fade/run/t/r [level]

t/r = tab/row of the fader.

[level] = float level from 0.0 (stopped) to 
1.0 (running at full level)

TX+RX

Run the cue or cuelist on the specified 
fader, with the specified level.

e.g. run fader on tab 2, row 7 at 30% 
level: /sc/fade/run/2/7 "0.3"

/sc/fade/label/t/r [name]

t/r= tab/row of the fader.

[name] = string containing the fader 
name

TX

Sends the name of a Show Control fader 
to the connected OSC controller.

When the Show Control window is 
opened, this message is sent for every 
fader in the window. This allows remote 
OSC controllers to display the real names 
of the Show Control faders. The message 
is also transmitted when the name of a 
Show Control fader is changed.

e.g.  name fader on tab 2, row 4: 
/sc/fade/label/2/4 "Blue Stage Left"

/sc/fade/speed/t/r [value]

t/r = tab/row of the fader.

[value] = float multiplier

RX

Sets the relative speed of oscillators 
running in the cue on this fader.

This allows the speed of oscillator-based 
chases to be adjusted on a cue-by-cue 
basis, in addition to the global speed 
control.

e.g. halve the speed of the fader on tab 1, 
row 6: /sc/fade/speed/1/6 "0.5"

/sc/fade/phase/t/r [phase]

t/r/c = tab/row of the fader.

[phase] = float between 0.0 and 1.0.

RX

Sets the phase (chase starting point) of 
the cue on this fader.

Only affects faders containing 
cues/cuelists with active oscillators.

e.g. start at fixture #7 of a 10 fixture 
chase: /sc/fade/phase/1/6 "0.7"
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SHOW CONTROL SNAPSHOTS

Command
Transmitted 
or Received 
by D-Pro

Description

/sc/snap/run/t/r/c [state]

t/r/c = tab/row/column of the snapshot 
button

[state] = 0 (stop) or 1 (start)

TX+RX
Run the specified snapshot.

e.g. /sc/snap/run/2/4/7 "1"

/sc/snap/label/t/r/c [name]

t/r/c = tab/row/column of the snapshot 
button.

[name] = string containing the snapshot 
button name

TX

Sends the name of a Show Control 
snapshot button to the connected OSC 
controller.

When the Show Control window is 
opened, this message is sent for every 
button in the window. This allows remote 
OSC controllers to display the real names 
of the Show Control buttons. The 
message is also transmitted when the 
name or position of a snapshot button is 
changed.

e.g. /sc/snap/label/2/4/7 "Blue Stage 
Left"
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REVISION HISTORY

RELEASE 1.8

• D-Pro 2U license now includes the PRO Mk2 Standalone Playback feature.

• Added momentary feature to Show Control. Allows flash buttons to be created. Works 
with mouse, keyboard & MIDI control.

• Added override feature to Show Control buttons & submaster faders. Allows direct 
control of one or more DMX channels, overriding all other current cues & cuelists.

• Art-Net sub-net and universe parameters added to the Preferences window.

• DMX output refresh rate can now be customised (per-show) from the Preferences 
window. 

• Improved speed of multiple cell edits in cuelist editor. Start triggers were taking several 
minutes to save with long cuelists.

• Improved Show Control mouse handling. Buttons activate immediately upon mouse key
presses. 

• Increased max Show Control fade times from 60s to 10 minutes.

• Patch window : can now edit unlverse:channel for multiple fixtures simultaneously. 
Handy for shifting blocks of RGB pixels around.

• Fixed keyboard handling on OS X - the system 'alert' sound is longer heard when 
pressing a key.

• Bugfix : in Patch window, fixed crash (and possible show file corruption) when a newly 
patched fixture exceeds channel 512.

• Bugfix : fixed ESC key handling (was not switching from command window back to 
original window)

• Bugfix : Fix 16 bit pan/tilt editor in programmer window, when 'fine' channels appear 
after the main 'pan/tilt' channels in the fixture definition.

• Bugfix : display help message when DMX USB PRO box running (incompatible) 2.4 
firmware is connected.

• Bugfix : D-Pro Player displays error message if last-opened D-Pro project not found.

RELEASE 1.7

• Added Show Control snapshots. (Allows you to quickly record & recall the state of the 
Show Control window)
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• Improved usability of config window in Show Control. (Multiple buttons & sliders can 
now be edited simultaneously)

• Added multiple selection to Library window:

◦ Multiple items can be dragged between folders. 

◦ Multiple cues can be dragged into a cuelist. 

◦ Multiple palettes can be dragged into the programmer. 

◦ Multiple cues & cuelists can be dragged into show control.

• Added “DIRECT CONTROL” option (Preferences > Remote Control screen) which 
allows an external controller to override the value of any DMX channels. Useful for e.g. 
manual control of moving head positions from an XY MIDI controller.

• [File > New Show...] displays a default project filename.

• Bugfix: [Preferences > Remote Control] operation was broken if OSC disabled.

• Bugfix: current MIDI trigger was not displayed in Event window.

• Bugfix: Fixed problems with 16-bit moving head fixtures with pan/tilt channels higher 
than channel 3. (Bug manifested itself as random zeroing of DMX channels 0-3 when 
playing a cuelist)

RELEASE 1.6.2

• Added OSC remote control.

• Oscillator pulse width resolution increased to 0.01% (was 1%)

• Bugfix: fixed intermittent startup crash on OS X.

• Bugfix: fixed MIDI latching behaviour for radio buttons on Show Control.

• Bugfix: MIDI control of Show Control speed slider was broken.

• Bugfix: fixed crashes when a device is set to "Not Patched" (0:0) in the patch window.

• Bugfix: prevent Show Control buttons from activating following a drag/drop operation.

RELEASE 1.5.6

• Added support for OS X 10.11 (El Capitan) and Windows 10

• Enhancement: Added support for the standard OS X serial FTDI driver on OS X 10.8+. 
The FTDI Driver Control utility is now redundant, and D-Pro is now compatible with 
other hardware (e.g. Arduino) that needs access to serial FTDI drivers. If required, the 
serial drivers can still be disabled via the driver control utility, and D-Pro will revert to 
using the D2XX drivers as in previous releases.
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• Bug fix: Fixed intermittent flashing on DMX outputs when editing in the programmer.

• Bug fix: oscillators not working on channels higher than the RGB channels on an RGB 
fixture.

• Bug fix: Show Control sliders were not setting DMX channels to maximum range.

• Bug fix: intermittent glitches in DMX output when running a cuelist from a Show Control 
radio button.

• Bug fix: crash in Device Browser grid tab when shift-selecting fixtures in reverse order.

RELEASE 1.5.3

• Fixed to work with MIDI input feature of the DMX USB Pro Mk2 hardware.

• Modified installers to check for minimum OS requirements (Windows Vista, OS X 10.7) 

RELEASE 1.5.2

• Bugfix: fx scripts now work reliably in D-Pro Player. 

• Cuelist window: Improved editing workflow. Cues can be selected by clicking in the 
timeline. The current playback position can be set by clicking in the table/timeline. 
Playback will not rewind following every edit.

• Cuelists: Fixed glitching in cuelist audio playback.

• Cuelist bugfix: Fixed fade problems with long in/out times. (Channels were jumping 
around with fade times > 10 seconds),

• Show Control: Added ‘Buttons latch via MIDI’ global option (selected from Preferences 
window). When active, buttons will toggle on/off in response to MIDI NoteOn and CC 
(value>64) messages. NoteOff and CC<64 are ignored. This lets you use MIDI 
controllers with no “latching” button behaviour. When the option is disabled, buttons will 
activate as before, via NoteON & NoteOFF messages and switch at CC level 64.

• Bugfix: Show Control buttons now react properly to MIDI Note On/Off and CC 
messages. Previously, the buttons could flicker on/off unreliably.

• Show Control: Added MIDI Out option. Sliders & buttons on Show Control can report 
their current settings in realtime to any chosen MIDI controller. (Configured from the 
Preferences window),

• Show Control: Tap Tempo and Resync buttons can now be controlled from keyboard 
(via Preferences > Remote Control).

• Show Control: ‘Reset Output’ button can now be remotely controlled (via Preferences > 
Remote Control).
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• Show Control bugfix: When a Show Control cuelist button was repeatedly activated by 
MIDI CC data, the CPU would overload.

• (Mac only) FTDI driver conflicts are now handled by D-Pro. The Apple FTDI driver, 
which causes comms problems with Enttec hardware, is automatically disabled 
whenever necessary. The Apple driver can also be manually enabled/disabled as 
required from the Preferences window. (It is still necessary to enter the OS X admin 
password when prompted).

• D-Pro on Mac is now a universal 32/64-bit application.

• Fixed 'Attribute Oscillator' FX script to work with any combination of RGBAW channels. 
(In previous releases, white channels could not be controlled FX scripts).

• Added reconnect all button to Preferences window (to allow Enttec hardware comms to 
be refreshed).

• Bugfix: fixed intermittent lock-ups of DMX output data,

• Reworked ‘Import Fixtures’ dialog (in Patch window). Now displays basic help and links 
to the online library.

• Improved reliability of hardware comms, DMX engine timing accuracy & general 
reliability.

RELEASE 1.4.2

New features & improvements

• Added support for PRO Mk2 MIDI input.

• Added PRO Mk2 standalone shows. (D-Pro 8U only)

• Added D-Pro Player (simple show player which displays only the Show Control window 
@ full screen. Ideal for use by staff in permanent installs at bars/restaurants etc)

• MIDI input devices can be selectively enabled & disabled from Preferences window.

• Improved CPU performance of Device Browser Physical panel.

• Improved performance when saving groups, opening cues into programmer, resetting 
the programmer.

• Various performance improvements for shows with large numbers of patched devices 
e.g. pixel arrays.

• Device Browser now hides text when zoomed small. Looks better for pixel mapping 
setups.

• Added French & Spanish language support

• Improved audio playback reliability and timing accuracy with longer cuelists.

Bug fixes

• Show Control bug fix - the round-robin feature broke the scenario where you have 
multiple blackout cues sharing the same trigger across multiple radio groups (only the 
first cue was triggering)

• Fixed glitches in DMX output when crossfading between cues in cuelists.
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• Fixed memory leak when working with cuelists containing multiple audio files.

RELEASE 1.3.1

New features & improvements

• Added support for multiple languages.

• Added pan/tilt faders to programmer XY pad (allows keyboard entry of pan tilt values).

• New look Show Control window.

• Improved cuelist behaviour. By default, only dimmer/colour/pan/tilt channels cross fade 
between cues. Other channel types (gobo, control, beam etc) will snap to their target 
value. The advanced timing menu still allows full customisation if necessary.

• Added tap tempo and resync FX buttons to Show Control. 

• Added remote control support for FX resync and direct tempo control (60-187bpm on a 
simple CC).

• Buttons in Show Control can be re-ordered by drag/drop.

• Panels in Show Control can now be hidden (Preferences window).

• Added “round robin” radio groups to Show Control. 

• Improved CPU performance.

• Added “UNPARK” command.

• Added "play immediate" cuelist option to Preferences window (when next/prev is 
selected in the timeline, the cue plays immediately instead of pausing the cuelist)

Bug fixes

• Fixed intermittent programmer crash following an edit in the patch window.

• Bugfix – Show Control stopped responding to trigger events following a change in 
Preferences|Remote.

• Bugfix - allow fade outs to complete in cuelists when pausing between cues (Previously,
fade-outs were pausing as well).

• Bugfix - 'fine' channels of 16 bit oscillators were not running accurately.

• Fixed reliability issues with 2U licensing system.

• Fixed corrupted message dialogs in Windows 8.

• Fixed USB hardware connection issues (serial number was not being initialised 
correctly in preferences window)

• Fixed 8U USB key issues on Windows 8.

• Fixed startup crash when no network connection available.

• Fixed intermittent Programmer crash in Python FX engine

• Fixed crash when shift-selecting first device in List tab of Device Browser.

• Fixed crash pressing Playback Wing flash button in learn mode.

• Cuelists - the existing cue now holds at the right level when waiting for a trigger. In 
particular, the level does not drop to zero when a trigger point is reached and the 
existing cue has a 0ms fade time.

• Apostrophes may now be used in cue names, cuelist names etc.
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• Prevent programmer from transmitting DMX changes for attributes that have not 
explicitly been modified. Fixed the problem where default values (e.g. Pan/Tilt = 
127/127 in the fixture profile) were being reset to 0/0 when the device is selected.

• Fixed OS X installer signing so that installer runs correctly on 10.6 (Snow Leopard).

RELEASE 1.3.0

New features & improvements

• OS X installer now supports Mountain Lion (gatekeeper)

• 8U and demo versions can be installed side-by-side on OS X. Allows offline editing 
when the 8U license key is unavailable. (Already possible on Windows)

• Device Browser can now display a background image (e.g. a picture of a stage or 
bar/restaurant)

• Every patched fixture can now display a fixed beam in the Device Browser (with custom
colour, direction, throw & beam angle). Greatly enhances the visualisation of rigs with 
traditional or LED parcans, especially when combined with the ability to load a 
background image

• Added scrollbars & zoom control to Device Browser (value is saved per-show).

• Added support for CMY, RGBA, RGBW and RGBAW fixtures to the programmer (colour
editor), device browser and online fixture editor.

• Each attribute in the programmer has an "active" button, showing at a glance which 
attributes have been modified.

• Clicking on a lit "active" button in the programmer will delete that attribute value from 
the recorder.

• Added display of audio waveforms (Cuelist and Show Control windows).

• Cue numbers are now displayed in cuelist timeline (as well as cue names)

• During cuelist playback, the current cue is highlighted (in both the timeline and the 
cuelist table)

• Added support for DMXIS footswitch input. A DMXIS footswitch can now start/stop 
Show Control buttons, drive cuelists and perform any global remote control actions.

• Programmer : the priority order of palettes & attributes can now be edited (via drag/drop
directly in the recorder table)

• Show Control GM and SPEED controls can now be controlled from MIDI (from 
Preferences window)

• When a show is loaded, missing fixture definitions can now be automatically 
downloaded from the online library.

• Added support for Enttec PRO2 box (new option in hardware preferences, allows 2 
universes to be output).

• Improved window colour scheme (now generates more visible contrasting colour for 
darker schemes)

• Added HH:MM:SS running clock to cuelist status text

• Improved layout & appearance of attribute panel in Programmer

• Drastically improved startup time of "Get new fixtures" dialog in Patch Window.

• A single-click on a group in the library window now loads it (previously required double-
click)
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• Added support for 16 bit crossfading in cuelists.

• Increased resolution of MIDI loop (to decrease MIDI controller latency)

• Window positions & sizes are now saved per-show. (Previously, window positions were 
global)

• Reduced CPU load of DMX Output window.

• Programmer "Save" button no longer prompts user.

• "Delete" button in Programmer now allows deleting single row or full table.

• Warn user before closing Show Control window, closing current show file, or closing 
application that the DMX output will be stopped.

• Ambiguous "clear" button in Programmer replaced with "reset" (which does a full reset 
of the window)

• Colour editor in Programmer now has clear 0-255 sliders

• Added crosshairs to Pan/Tilt pad in programmer.

• Improved performance when changing levels of multiple devices from the command 
line.

• Show Control now updates automatically on palette changes.

• Cuelists now update (following programmer/cuelist window saves) without stopping 
cuelist playback.

• Display generic faders in percent, not 0-255.

• Remember Library node openness when saving new cues, cuelists etc. (Previously, all 
child folders would close)

Bug fixes

• Cuelists: fixed errors in timing & playback of audio files.

• Fixed OS X file permissions on fixture database. (In some cases, a write error 
prevented new fixtures from being added).

• Can now add a palette multiple times to a cue (with different device selections). 
Previously gave an SQL error.

• Command line: Fixed double character when first typing (windows only)

• Command line: Deselect all devices when clearing the line following a selection 

• Command line: Typing "G10" would select both groups G1 and G10.

• Fixed command line bugs on Mac: dynamic parsing (where device selections happen 
as you type) was broken. This in turn broke the overall group/device selection 
mechanism.

• Show Control window now updates automatically when underlying cues or cuelists are 
modified.

• Pan/Tilt LSB values were not being recorded in cues.

• Improved Programmer window handling. Now prompts user consistently to save edits 
before closing or reloading.

• Last selected group in device browser could not be reselected following a programmer 
reset.

• Programmer window intermittently prompting for save even when nothing was edited.

• Fixed crash opening Show Control when Library window is closed.

• Values were not saved properly when clicking and typing a value on an attribute fader.

• The Grand Master fader now fades RGB channels.
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• Can now edit universe:channel in the patch window.

• Fix crash on exit.

• Fixed crash when selecting "edit" in preferences/output tab after deleting an output.

• Fixed crash when selecting devices e.g. 4-1 in the grid or list tab of the device browser.

• Can now assign a group number "0" (previously, group 0 would not load from cmd line 
properly)

• Output data is cleared when Programmer blind mode is activated.

• Fixed timing inaccuracies in cuelists. Each event was slipping by 40ms (1 frame). With 
long cuelists the inaccuracies would get worse as the show progressed.

RELEASE 1.2.2

• Added 'File > Save Show As' menu option.

• Added  'File > Recent shows' menu.

• Main window: Fixed error when trying to save a new show using the name of an existing
file.

• Enttec wing support: added support for Back/Go buttons on Playback wing..

• Command line: fixed crash when Device Browser window not open and command is 
typed.

• Show Control: fixed bug where cuelists could not be dragged onto pages 2 or higher.

• Command line: fixed crash when trying to adjust dimmer levels of devices with no 
dimmer channel 

RELEASE 1.2.1

New features

• Device Browser: Added arrange menu to physical tab (horizontal/vertical/grid layout of 
selected devices.

• Show Control: Added Reset button to Show Control window (returns all channels to 
default and stops all cues/cuelists).

• Patch window: Window contents are updated immediately when new fixtures imported 
(previously a reload of the show was required).

Issues fixed

• Cuelist/Show Control windows: fixed problem where FX from the next cue were loading 
too early, when a cuelist is paused waiting for a hardware event.

• Show Control: Devices with additional colour channels (e.g. RGBAW) now crossfade 
correctly.

• Cuelist window: Improved cuelist save time.

• Programmer: Improved time taken to open complex cues.

• Device Browser: Improved response times in physical tab (when moving devices).

• Show Control: When crossfading between buttons in a radio group, dimmer levels no 
longer "dip".

• Cuelist window: Improved behaviour of audio event playback.
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• Patch window: Login dialog now hides the password.

• General: Fix crash when fixtures unpatched from a show. Now warns when unpatched 
devices are found in a cue/palette.

• File handling: Switched to standard file>open and file>new dialogs (more reliable 
operation, allows creation of folders).

• File handling: Allow shows to be loaded & saved with any file extension (do not enforce 
use of '.dsf').

• Patch window: Removed Import All button. Too slow to be useful.

• General: Added support for fixtures with multiple dimmer channels

• DMX output: Improved accuracy of DMX timing.

RELEASE 1.2.0

New features

• Patch window: Private fixture definitions can now be imported (simply click on "Get new 
fixtures..." then enter your fixture editor login details)

• Cuelist window: Added support for dragging WAV, AIFF, FLAC, CAF audio files into 
timeline.

• Progress dialog is now displayed when connecting to Enttec DMX hardware.

• Programmer window: Added RGB faders.

• Main window: simplified PATCH command and updated associated help text.

Issues fixed

• Show Control & Cuelist windows: Fixed lock-up when cuelist stops playing at a cue with
'Action when done' = 'Stop cuelist'.

• Show Control window: Fixed crash when modifying properties of a button which is 
running;

• Show Control & Cuelist windows: Cues in a cuelist with 'Out' = 'No Fade' were not 
holding their values.

• Cuelist window: Fixed timeline rendering of cues where 'Out' = 'No Fade'.

• DMX engine: Fixed glitches in DMX output when Speed>100%.

• Programmer window: Fixed crash when displaying attributes for a device which has 
errors in its fixture definition. 

• Show Control window: Fixed intermittent lockup.

• Programmer: Fixed error when trying to modify & save a cue containing palettes.

• DMX engine: Fixed playback of cues with multiple palettes (when device filters are 
applied)

RELEASE 1.1.0

• Initial public release
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